A Practical Guide to
AutoCAD® 2020

Tracy Chadwick and Rick Ellis
Foreword written by Lynn Allen

A CADapult Press Publication

Copyright
Copyright © CADapult Press, Inc. 2019
All rights reserved. No part of this publication may be reproduced in any form, or by any means electronic,
mechanical, recording, photocopying, or otherwise, without written permission from the publisher, except for
brief quotations used in reviews, or for marketing purposes specific to the promotion of this work.
ISBN: 978-1-934865-43-9
Although CADapult Press has made every attempt to ensure the accuracy of the contents of this book, the
publisher and author make no representations or warranty with respect to accuracy or completeness of the
contents in this book, including without limitation warranties of fitness for a particular purpose. The datasets
included in this book are for training purposes only.
Autodesk screen shots reprinted with the permission of Autodesk, Inc.
Autodesk, AutoCAD, DWG, and the DWG logo are registered trademarks or trademarks of Autodesk, Inc.,
and/or its subsidiaries and/or affiliates in the USA and other countries. All other trademarks are the property
of their respective owners.
Published in the United States of America by:
CADapult Press
(503) 829-8929
books@cadapult-software.com
Printed and manufactured in the United States of America

ii

About the Authors
Tracy Chadwick serves as coordinator and instructor for the Computer Drafting Technology program at
Hutchinson Community College in Hutchinson, Kansas. He is responsible for teaching a wide range of
courses, including those on engineering graphics, AutoCAD software, Inventor software, and Revit
Architecture software.
Tracy has been an AutoCAD user since 1995, and has been teaching AutoCAD classes to working
professionals and college students since 2001. His experience and dedication to teaching led to him being
recognized by Autodesk, Inc. with the North America Award for Distinguished Performance in AutoCAD
Software Training.
Tracy has also been recognized as a top rated speaker at Autodesk University, where he has presented for
several years. He has recently begun serving as a mentor to first-time Autodesk University speakers.
Tracy can be reached at: tracy@cadapult-software.com

Rick Ellis has worked with and taught AutoCAD Map 3D since the mid-90s, along with Civil 3D and other
Autodesk products. He is the Author of several critically acclaimed books on AutoCAD Map 3D, Civil 3D and
Land Desktop.
Rick continues to use AutoCAD Map 3D on projects in a production environment, in addition to teaching
classes to organizations both large and small.
This practical background and approach has made him an award winning speaker at Autodesk University and
a sought after instructor by organizations around the world.
Rick can be reached at: rick@cadapult-software.com

Acknowledgements

Thank you to my wonderful wife Candace, and my two amazing daughters Sydney and Casey. Without their
support I could never have completed this book. Thank you to all the students of the Computer Drafting
Technology program at Hutchinson Community College. I am honored to have played a part in helping so
many students achieve fulfilling careers over the last two decades. Thank you to Vince Puyear, who first
introduced me to AutoCAD back in 1995. He started as my instructor, then later became my colleague,
mentor, and friend. Thank you to Amber Brawner for lending her graphic design talent to this book, and for
being a great friend. Last, but not least, thank you to Rick Ellis and CADapult Press for helping me to achieve
my dream of being an author, so that I may spread my love for AutoCAD from beyond central Kansas to the
world!
-Tracy Chadwick

iii

A Practical Guide to AutoCAD® 2020
Introduction

Congratulations on choosing this course to help you learn how to use AutoCAD 2020. The term “practical” is
used in the title because this course focuses on what you need to effectively use AutoCAD 2020, and does
not complicate your learning experience with unnecessary details of every feature in the product. Should you
want to pursue aspects of features and functionality in greater detail than provided in this course, you are
directed and guided to that information.
Each lesson contains the concepts and principles of each feature to provide you with the background and
foundation of knowledge that you need to complete the lesson. You then work through exercises to reinforce
your understanding and provide you with practice on common tasks that other professionals are performing
with AutoCAD 2020 in the workplace every day.
When you complete this course, you will be armed with the background and knowledge to apply AutoCAD to
your job tasks, and become more effective and productive in your job.

Course Objectives

The objectives of this course are performance based. In other words, once you have completed the course,
you will be able to perform each objective listed. If you are already familiar with AutoCAD, you will be able to
analyze your existing workflows, and make changes to improve your performance based on the tools and
features that you learn and practice in this course.
After completing this course, you will be able to:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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Understand the user interface
Navigate through drawings with pan and zoom commands
Create drawing objects, including lines, arcs, and circles
Create and modify polylines, including rectangles and polygons
Use Layers to differentiate drawing objects
Draw using Polar Tracking and coordinate methods
Use Object Snaps and Object Snap Tracking
Modify drawing objects
Duplicate drawing objects
Extract information from drawings with measuring tools
Create and modify hatch patterns
Create, insert, and modify blocks
Work with external references
Import a PDF
Create and scale paper space layouts and viewports
Print scale drawings and check plots
Detail drawings with text, dimensions, and leaders

Downloading and Installing the Datasets

In order to perform the exercises in this book, you must download a zip file and install the datasets.
Type the address below into your web browser to load the page where you can download the dataset.
www.cadapult-software.com/data

Unzip the Files

Unzip the file APG_AutoCAD2020.zip directly to the C drive. The zip file will create the following folder
structure:
C:\A Practical Guide\AutoCAD 2020\Files for Exercises

Exercises

The exercises in this course have been carefully chosen and designed to represent common tasks that are
performed by design professionals.
The exercise files are from many different industries, and are meant only to be examples. It’s important to
focus on the tools being shown and how you could apply them to your project and industry.
Exercises provide higher level process information throughout the exercise tasks. You are given information
about not only what to do, but why you are doing it. In most cases, an image is included to help guide you.
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Foreword
Welcome to the wonderful world of AutoCAD. I say that somewhat tongue and cheek as learning AutoCAD
can be somewhat daunting – and no doubt why you’ve chosen to pick up this book. I commend you for not
trying to learn AutoCAD completely on your own (a dreadful route to take) but for relying on the skillful
guidance of Tracy Chadwick and Rick Ellis. These two award winning authors have been teaching AutoCAD
for many years and know exactly what it takes to lead the beginning user through the oft overwhelming tools
inside of AutoCAD. This A Practical Guide of AutoCAD 2020 will focus on the all-important basics of the
product and steer you clear of the nonessential tools (you can tackle those later when you are more
seasoned!) There is a right and a wrong way to use AutoCAD…this book will ensure that you learn how to
use it the “right” way!
I taught AutoCAD at the collegiate and professional level for 11 years before joining Autodesk in their training
department. I know the importance of good training materials and I know a great AutoCAD book when I see
it. You are looking at one right now. Tracy and Rick have mastered the art of writing in terms that we can all
understand without a need to impress or complicate the task at hand. Their goal is simple: to help you
successfully use AutoCAD for your design work. They have taken their many years of training expertise and
rolled it all into this well massaged book. How I wish I’d had this book when I was training people how to use
AutoCAD!
In my 20+ year role as Autodesk Evangelist, I had the distinct privilege of working with Tracy and Rick at
Autodesk University and other conferences. Their presentations are always highly rated and very popular
with attendees. They have that special knack of connecting with an audience and making the difficult sound
easy – which is exactly what you need when you are learning to use AutoCAD. You will experience this as
you make your way through the chapters of this book.
A Practical Guide of AutoCAD 2020 also includes real-world examples from many different industries. You
won’t be drawing any Mickey Mouses or smiley faces, but actual drafting examples. Let’s face it – you
wouldn’t get a job with that limited skillset (well…unless you go work for Disney). The variety of practical
examples used with practical commands is the perfect combination to get you prepared for drafting and
designing in the real world.
Use this book to build a firm foundation for designing with AutoCAD. Those users with a firm foundation of
the product do best overall in successfully mastering the product (another reason to read this book).
Physically do as many exercises in the book as possible and you’ll be on the road to becoming a great
AutoCAD user!
I’m pretty sure that your first thought when you’re finished with this book is going to be…”When are Tracy and
Rick going to come out with an Advanced Practical Guide of AutoCAD?” I know that’s my question!

Lynn Allen
Global Technology Evangelist
In her 20+ year career as Autodesk Technology Evangelist, Lynn Allen has spoken to more than a half million
design professionals in over 50 countries throughout the world. Her online reach over the years easily
reaches into the millions. An early CAD entrepreneur, Lynn taught AutoCAD at the corporate and collegiate
level for 11 years before joining Autodesk. A popular columnist for Cadalyst magazine for over two decades,
she is the face behind hundreds of software videos including the series “AutoCAD Tips and Tricks with Lynn
Allen”. A sought-after public speaker with a unique comedic style, Lynn was the host of Autodesk University
for over a decade and is always one of the highest rated presenters at the many worldwide Autodesk
Universities. She is also the author of three technical books focused on AutoCAD software.
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Sample Lesson

Chapter: Modifying Drawing Objects

6.4.

Rotating Drawing Objects

Introduction

In this lesson, you learn how to rotate drawing objects.

Key Concepts

Concepts and key terms covered in this lesson are:
•
•
•
•

Rotating Objects
Base Point
Rotation Angle
Reference Angle

Objectives

After completing this lesson, you will be able to:
•

Rotate drawing objects.

Rotating Drawing Objects
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About the Rotate Command

Many times while drawing you will have the need to adjust the orientation of drawing objects
by rotating them. The Rotate command can achieve this in a few simple steps.

Starting the Rotate Command

The Rotate command is located at Ribbon: Home ⇒ Modify ⇒ Rotate.
Alternatively, you can type RO then press [Enter] at the keyboard.

After starting the Rotate command, you are prompted to select the objects to be rotated.

The Rotate command will allow you to select as many objects as you want. When you are
finished selecting objects you must press [Enter] at the keyboard to move on to the next
step.

Next you will specify the base point. This point will remain in the same location while the rest
of the selected objects rotate around it.

Finally, the Command line asks for the rotation angle. The angle can be specified by typing a
value or by selecting a point on-screen.

When entering a rotation angle value, it is important to remember that by default in AutoCAD,
angles are positive when rotating in the counterclockwise direction; angles are negative when
rotating in the clockwise direction.
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Instead of typing the rotation angle value, you can also pick a point on-screen. Turn on Polar
Tracking to ensure that the rotation angle is precise. In the example below the Incremental
Angle value of Polar Tracking has been set to 30 degrees. This could be a more efficient
workflow because you do not need to be concerned with whether or not an angle is positive
or negative. Instead, you simply click when the object is located on the appropriate tracking
angle.

Specifying the Reference Angle

Occasionally when working in a drawing, you may find
the need to rotate an object to return it to a standard
orientation. For example, the bolt in the image to the
right is currently at an angle, and it needs to be rotated
until it is back to horizontal.
This is a fairly simple process if the object was rotated at a known angle, such as 30 degrees;
you could simply rotate the object negative 30 degrees to return it to horizontal. However, if
the object has been rotated at an unknown angle, the process could be more difficult. One
possibility is to measure the angle from horizontal, then rotate using a negative value.
In the image to the right, the angle of the bolt has been
measured and found to be nine degrees.

The first instinct might be to rotate the object negative
nine degrees to return it to horizontal. This might not
work precisely, because the nine degree dimension
could be rounded off. A closer look reveals that the angle
is slightly less.
Using this new, more precise value could still lead to an incorrect drawing because this value
is most likely rounded off as well.
The much more precise and quicker solution is to use the Reference option of the Rotate
command.

Rotating Drawing Objects
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In this example the centerline of the bolt will serve as the reference angle. Therefore, the left
endpoint of the centerline will serve as the basepoint.
1. Begin the Rotate command and select the
objects to be rotated.
2. Specify the basepoint.
3. Choose the [Reference] option in the Command line.

4. Select the two endpoints of the centerline to represent the new reference angle.

5. Move the crosshairs horizontally to the right
of the basepoint along the 0 degree Polar
Tracking angle.
6. Select a point to rotate the bolt into place.

Exercises: Rotating Drawing Objects

In these exercises, you will rotate several drawing objects.

You do the following:
•
•
•
•
•
•
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Start the Rotate command.
Select objects.
Specify base points.
Specify a rotation angle by typing a value.
Specify a rotation angle with Polar Tracking.
Use the reference option to orient drawing objects.

Rotating Drawing Objects
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6.4.1

Rotating Drawing Objects

In this exercise you will use the Rotate command to adjust the orientation of several doors.

1. Open drawing 6.4.1 Rotating Objects 1.dwg.
2. Set Endpoint as a Running Object Snap.
Four doors have been placed, but they need to be rotated into place. Start with the door in
the lower left, then work clockwise around the building.
3. Zoom to the lower-left quadrant of the building.
4. Select Ribbon: Home ⇒ Modify ⇒ Rotate.

5. Select the door.
6. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.
7. Select the point where the arc touches the
wall to specify it as the base point.

You are now prompted to specify the rotation angle.
8. At the Command line type 90 then press [Enter] at the keyboard.
The door is rotated into place.
9. Zoom to the upper-left quadrant of the building.

Rotating Drawing Objects
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10. Select Ribbon: Home ⇒ Modify ⇒ Rotate.

11. Select the door.
12. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.
13. Select the point where the arc touches the
wall to specify it as the base point.

You are now prompted to specify the rotation angle.
14. At the Command line type 45 then press [Enter] at the keyboard.
The last two doors will be rotated in the clockwise direction, which will require negative
rotation angles.
15. Zoom to the upper-right quadrant of the building.
16. Select Ribbon: Home ⇒ Modify ⇒ Rotate.

17. Select the door.
18. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.
19. Select the point where the arc touches the
wall to specify it as the base point.

You are now prompted to specify the rotation angle.
20. At the Command line type -45 then press [Enter] at the keyboard.
Next you will rotate the final door.
21. Zoom to the lower-right quadrant of the building.
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22. Select Ribbon: Home ⇒ Modify ⇒ Rotate.

23. Select the door.
24. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.
25. Select the point where the arc touches the
wall to specify it as the base point.

You are now prompted to specify the rotation angle.
At the Command line type -90 then press [Enter] at the keyboard.
The completed drawing appears as shown.
26. Save the drawing.

Rotating Drawing Objects
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6.4.2

Rotating Objects with Polar Tracking

In this exercise you will use the Rotate command and Polar Tracking to speed up the rotate
process.

1. Open drawing 6.4.2 Rotating Objects 2.dwg.
2. Set Endpoint as a Running Object Snap.
3. Select the fly-out arrow next to the Polar Tracking button and select
45 degree increment angles.
4. If necessary, select the Polar Tracking button to turn it on.

5. Zoom to the lower-left quadrant of the building.
6. Select Ribbon: Home ⇒ Modify ⇒ Rotate.

7. Select the door.
8. Press [Enter] at the keyboard to finish selecting objects.
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You are now prompted to select the base point.
9. Select the point where the arc touches the wall
to specify it as the base point.

You are now prompted to specify the rotation angle.
10. Move the crosshairs above the previous point,
until it snaps on to the 90 degree Polar Tracking
angle, then select a point.

The door is rotated into place.
11. Zoom to the upper-left quadrant of the building.
12. Select Ribbon: Home ⇒ Modify ⇒ Rotate.

13. Select the door.
14. Press [Enter] at the keyboard to finish selecting objects.

Rotating Drawing Objects
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You are now prompted to select the base point.
15. Select the point where the arc touches the
wall to specify it as the base point.

You are now prompted to specify the
rotation angle.
16. Move the crosshairs above and to the right
of the previous point, until it snaps on to the
45 degree Polar Tracking angle, then select
a point.

17. Repeat the process to complete the right side of the drawing.
18. Save the drawing.

6.4.3

Rotating Objects with the Reference Option

In this exercise you will use the Reference option of the Rotate command to adjust the
orientation of an object.

1. Open drawing 6.4.3 Rotating Objects 3.dwg.
2. Set Endpoint as a Running Object Snap.
A bolt head has been rotated at an unknown angle. You will rotate it until the top and bottom
edges are horizontal.
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3. Select Ribbon: Home ⇒ Modify ⇒ Rotate.

4. Select the objects that make up the bolt head.
5. Press [Enter] at the keyboard to finish selecting objects.
You are now prompted to select the base point.
6. Select the lower-left corner to specify it
as the base point.

You are prompted for a rotation angle. By default, AutoCAD uses 0 as the reference angle,
meaning that you are rotating from horizontal. In this case the reference angle should match
the bottom edge of the bolt head. Since that value is unknown, you will select the two
endpoints of that line to specify it as the new reference angle.
7. At the Command line select the [Reference] option.

You are prompted to specify the reference angle.
8. Click the lower-left point.
9. Click the lower-right point.
The reference angle now matches the bottom edge
of the bolt head.

10. Move the crosshairs horizontally to the
right along the 0 degree Polar Tracking
angle.
11. Select a point to rotate the bolt head into
place.
The top and bottom edges of the bolt head are now horizontal.
12. Save the drawing.

Lesson Review

In this lesson, you learned how to rotate drawing objects both by typing angle values at the
Command line and with the aid of Polar Tracking.
Rotating Drawing Objects
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A Practical Guide to Autodesk Civil 3D 2020
Introduction

Congratulations on choosing this course to help you learn how to use Autodesk Civil 3D 2020. The term
“practical” is used in the title because this course focuses on what you need to effectively use Autodesk Civil
3D 2020 and does not complicate your learning experience with unnecessary details of every feature in the
product. Should you want to pursue aspects of features and functionality in greater detail than provided in this
course, you are directed and guided to that information.
Each lesson contains the concepts and principles of each feature to provide you with the background and
foundation of knowledge that you need to complete the lesson. You then work through real world exercises to
reinforce your understanding and provide you with practice on common tasks that other professionals are
performing with Autodesk Civil 3D 2020 in the workplace every day.
You can take the lessons in this course in whatever order is appropriate for your personal needs. If you want
to concentrate on specific features, the lesson for those features does not require that you complete prior
lessons. With this course organization, you can customize your own individual approach to learning Autodesk
Civil 3D.
When you complete this course, you will be armed with the background and knowledge to apply Autodesk
Civil 3D to your job tasks, and become more effective and productive in your job.

Course Objectives

The objectives of this course are performance based. In other words, once you have completed the course,
you will be able to perform each objective listed. If you are already familiar with Autodesk Civil 3D, you will be
able to analyze your existing workflows, and make changes to improve your performance based on the tools
and features that you learn and practice in this course.
After completing this course, you will be able to:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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Understand and work with Object Styles.
Create, manage and apply Label Styles.
Import and manage Points, and work with Point Groups.
Create and edit Alignments.
Define Parcels.
Create and edit Profiles and Profile Views.
Create Corridors and extract information from them.
Sample Sections and plot Section Views.
Import and leverage GIS Data in your Civil 3D projects.
Use Queries to manage and share data.
Layout Pipe Networks and edit them in plan and profile.
Layout Pressure Networks and edit them in plan and profile.
Create Sheets with the Plan Production tools.
Work with the Grading tools.
Create reports for Civil 3D objects.
Calculate Volumes.
Share project data with Data Shortcuts.

Prerequisites

Before starting this course, you should have a basic working knowledge of AutoCAD. A deep understanding
of AutoCAD is not required, but you should be able to:
•
•
•
•
•
•

Pan and Zoom in the AutoCAD drawing screen.
Describe what layers are in AutoCAD, and change the current layer.
Create basic CAD geometry, such as lines, polylines and circles.
Use Object Snaps.
Describe what blocks are, and how to insert them.
Perform basic CAD editing functions such as Erase, Copy, and Move.

If you are not familiar with these functions, you can refer to the AutoCAD Help system throughout the course
to gain the fundamental skills needed to complete the exercises.

Conventions

The course uses the following icons and formatting to draw your attention to guidelines that increase your
effectiveness in Autodesk Civil 3D, or provide deeper insight into a subject.
The magnifying glass indicates that this text provides deeper insights into the
subject.

The compass indicates that this text provides guidance that is based on the
experience of other users of Autodesk Civil 3D. This guidance is often in the form of
how to perform a task more efficiently.
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Downloading and Installing the Datasets

In order to perform the exercises in this book, you must download a zip file and install the datasets.
Type the address below into your web browser to load the page where you can download the dataset.
www.cadapult-software.com/data
If you are using a previous version of Civil 3D you can download previous versions of the dataset to use with
this book.

Unzip the Files

Unzip the file APG_C3D2020.zip directly to the C drive. The zip file will create the following folder structure:

A folder called Chapter Drawings is created that contains a drawing that can be used to begin each exercise.
This will allow you to jump in at the beginning of any exercise in the book, and do just the specific exercises
that you want, if you do not have time to work through the book from cover to cover. The drawings in the
Chapter Drawings folder are not necessary and only need to be used if you want to start in the middle of the
book, or if you want to overwrite any mistakes that you may have made in previous chapters.
Three drawing templates called _Practical Guide Training by Style.dwt, _Practical Guide Plan & Profile.dwt
and _Practical Guide Section.dwt are also available in the template folder.

Exercises

The exercises in this course have been designed to represent common tasks that are performed by civil
engineers, surveyors, designers and drafters. The data included in the exercises are typical drawings, point
files and other data used by professionals like you. You work with drawings, point files, aerial photos, GIS
data, and much more; as you work through a road design project that also includes a sewer extension and
detention pond.
Exercises provide higher level process information throughout the exercise tasks. You are given information
about not only what to do, but why you are doing it. In most cases, an image is included to help guide you.
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Sample Lesson

Chapter: Building a Survey Quality Surface

5.1

Lesson: Building Surfaces from Survey Data

Introduction

Any time you build a surface the most important step is to understand what data you have
available to work with. In this chapter, you will work with points that will be managed with a
Point Group and breaklines that you will create based on some of those same survey points.

Key Concepts

Concepts and key terms covered in this lesson are:
•
•
•
•
•

Surface
Points
Point Group
Breaklines
Surface Styles

Objectives

After completing this lesson, you will be able to:
•
•
•
•
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Create a Point Group for use building a Surface
List the types of data that can be used to build a Surface.
Describe what a breakline is.
Draw and define breaklines.
Lesson: Building Surfaces from Survey Data
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Types of Surface Data

Surfaces can be built from a combination of many different types of data:
•
•
•
•
•
•
•
•
•

Boundaries
Breaklines
Contours
DEM files (Digital Elevation Models)
Drawing Objects
Point Files
Point Groups
Point Survey Queries
Figure Survey Queries

Boundaries

A boundary is a closed polygon that limits the triangulation of a surface.

Boundary Types:
•

•

•

•

Outer
o Defines the outer boundary of a surface
o Triangles outside of this boundary are removed
Show
o Displays the triangles inside the boundary
o Can be used inside of a Hide boundary
Hide
o Removes triangles inside of the boundary
o Creates a hole in the surface
o Can be used for building footprints to keep contours from crossing through them
Data Clip
o Keeps data outside this boundary from being added to the surface
o Must be added before other surface data or moved up in priority in the surface definition
o Useful for limiting the size of large datasets
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Non-destructive breakline boundaries

Outer, Show and Hide boundaries have the option to be created as non-destructive
breaklines. When this option is enabled it trims the TIN lines at the boundary. When it is not
used it erases all the TIN lines that touch the boundary.
This can be a good option if you have good surface data on each side of the boundary as it
will cut a clean and straight boundary through the surface. However, if this option is used on
an outer boundary where all of the surface data is inside the boundary and the only triangle
touching it are long and inaccurate, then you may be left with short triangles along the edge
that are still at the wrong slope.

Breaklines

Breaklines define grade breaks in a surface. They are lines in a TIN that represents a distinct
interruption in the slope of a surface; like road centerlines, curbs, gutters, streams, tops and
toes of slopes, or any other grade break. No triangle in a TIN may cross a breakline (in other
words, breaklines are enforced as triangle edges).

Types of breaklines:
•
•

•

•
•
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Standard
o Defined by selecting 3D polylines, 3D lines, feature lines, or splines
Proximity
o Defined by selecting a 2D polyline, feature line or spline
o The vertices of the breakline are snapped to the nearest point in the TIN, or closest proximity
o Accuracy is dependent on how close the vertices of the proximity breakline are to the points
in the TIN
o Can be very accurate and efficient if you have drawn the selected object from point to point
Wall
o Defined by selecting 3D polylines, 3D lines, feature lines, splines or by selecting points.
o You enter the elevation on each side of the wall at each vertex
From file
o Can be imported from an ASCII FLT file
Non-destructive
o Break the triangles in the TIN without changing the slope of the lines
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Contours

Contour data in the form of 2D polylines can be added to your surface.

Weeding factors can help you skip over extra, unnecessary vertices when the data is added
to the surface. While supplementing factors will allow you to sample extra points off long
contours with minimal vertices.
Since by its nature, contour data tends to create flat triangles that do not accurately reflect
the surface, there are several options to minimize those flat triangles. In most cases it is a
best practice to enable all four options to minimize flat areas when adding contour data to a
surface.

DEM Files

DEM files (Digital Elevation Models) are grid based surfaces. This is a format that is used by
many different Civil, Survey, and GIS programs.

DEM files are a format that is commonly used by the USGS and there is a
tremendous amount of data that is available online for free in this format.

Drawing Objects

AutoCAD object that have elevations can be used to build a surface. These objects include:
•
•
•
•
•
•

Points
Lines
Blocks
Text
3D Faces
Polyface

Lesson: Building Surfaces from Survey Data

165

Chapter: Building a Survey Quality Surface

Point Files

ASCII point files can be imported directly into the surface. This is a good option for large
datasets or points that you do not need in the drawing for anything other than building a
surface.

Point Groups

Point groups can be used to add a specific selection set of points to a surface. It may be
common that some of the points in your drawing are not related to a surface. For example,
you would not want to include a point representing the invert of a manhole in the surface. A
point group consisting of only surface related points is an efficient way to add only the
appropriate points to the surface.

Point Survey Queries

Point Survey Queries are a dynamic reference to a selection of survey points that are
included in a survey database. If the points in the survey database are updated, the surface
will be marked as out of date and will use the updated values when it is rebuilt.

Figure Survey Queries

Figure Survey Queries are a dynamic reference to a selection of survey figures that are
included in a survey database. If the figures in the survey database are updated, the surface
will be marked as out of date and will use the updated values when it is rebuilt.

Exercises: Build a Surface from Survey Data

In these exercises, you create a new surface from point group data. You will draw breaklines
from survey points and add them to the surface. Then you will view the surface in the Object
Viewer to examine it in 3D from different angles.

You do the following:
•
•
•
•
•
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Create a Point Group of surface related points.
Create a Surface.
Draw Breaklines.
Add Breaklines to the Surface.
View the Surface in 3D using the Object Viewer.
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5.1.1

Creating a Point Group to Be Used As Surface Data

Before you create the surface you need to create a Point Group that will be used to select
only the points that you want to use for the surface data. Points that should not be included
in the surface should not be included in the point group. Points for utility potholes or points
that are part of the project for horizontal control and do not have accurate surface elevations
are examples of points that should not be included in this group.
1. Continue working in the drawing Design.dwg.
This drawing contains the Points, Alignment, Parcels, and Surface from the previous
chapters. Currently only the parcel lines and labels are displayed.
Reminder: You can also open the drawing with this exercise number in the
Chapter Drawings folder of the dataset if you prefer a fresh start at this point.
2. On the Prospector tab of the Toolspace, right-click on Point Groups and select ⇒ New.
3. Enter Topo for the Name.
4. Select the Raw Desc Matching tab in the Point Group Properties dialog box.

5. Select the description keys AEC, DT, DWYRK, DWYAC, GND, LP, TOE, and TOP.
6. Click <<OK>> to create the Point Group.
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5.1.2

Creating the Survey Surface
1. On the Prospector tab of the Toolspace, right-click on Surfaces and select ⇒ Create Surface.
2. Confirm that TIN surface is
selected as Type.
3. Enter Survey for the Name.
4. Set the Style to Border &
Contours.
5. Confirm the Surface layer is set
to C-TOPO-Survey.

This layer name that includes the surface
name as a suffix was setup in an earlier
exercise through the Drawing Settings
command.
6. Click <<OK>> to close the
Create Surface dialog box and
create the surface.
At this time the surface has not been given any data so it is not displayed. However, it has
been created and you will see it in the Prospector. This is where you will access the surface
definition commands and add data to the surface.

5.1.3

Adding Point Group Data to a Surface

Point information contained in a Point Group can be added to a Surface through the
Prospector. Once the Point Group is added the Surface is automatically rebuilt to incorporate
and display the new data.
1. On the Prospector tab of the Toolspace, expand Surfaces.
2. Expand the Surface Survey.
3. Expand the Definition node under Survey.
4. Right-click on Point Groups under Definition and select ⇒ Add.
5. Select the Point Group Topo.
6. Click <<OK>> to add the point group data to the
surface.
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The surface is built with the point group data and displays 5 foot contours colored brown and
green with a yellow border. This display is controlled by the surface style you selected when
you created the surface. If the surface is not visible turn on and thaw the layer C-TOPOSurvey.

5.1.4

Creating Breaklines by Point Number

Civil 3D does not use special commands for drawing and defining breaklines the way that
Land Desktop and many other programs do. Instead, you draw the breaklines with standard
AutoCAD commands, like the 3D Polyline command, and then define these objects as
breaklines after they have been drawn.
1. Create a new Layer named Breaklines-Survey and set it Current.
2. Thaw the layers PNTS-AEC, PNTS-BREAK, and
PNTS-DRIVEWAY.
3. Freeze the layers C-ANNO, C-PROP, C-PROP-LINE,
C-PROP-TABL, EX-WETLAND-LINE, and PNTS-WTLND.
The drawing will now display the surface as contours and points that you will use for
breaklines. You may need to Regen to clean up the display.
4. Enter 3P at the command line to start the 3D Polyline command.
5. Enter 'PN to change the prompt to Point Number.
Alternatively, you can also select the Point Number button
Commands toolbar.

from the Transparent

6. At the command line enter: 1408-1447 and [Enter] to draw the line.
7. [Esc] to end the Point Number prompt.
8. [Enter] to end the line.
9. Enter 3P at the command line to start the 3D Polyline command.
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10. Use the points in the following list of points to draw the breaklines the same way that you drew
the previous line. Be sure to use the Point Number transparent command to change the prompt
to Point Number and to end the command completely after drawing each line. Also be sure to
[Enter] after each non-sequential point number as shown below in the list.
Point Numbers
1448-1486
1008-1021
1191-1209
1226-1257
1258-1278
1281-1324
1295 [Enter] 1661-1710
1622-1660 [Enter] 1294
1286 [Enter] 1348-1398 [Enter] 1287
1022-1074
1075-1105
1155-1158
1159-1160
1153-1154
1143-1151
1130-1142
1121-1129
The new 3D Polylines will look like the graphic below. However, they have not yet been
added to the surface as breaklines.

5.1.5

Creating Breaklines by Point Selection
1. On the Prospector tab of the Toolspace, select the Point Group Breaklines.

This will display a list of all the points used in the surface in the preview window at the bottom
of the Prospector, if the Prospector is docked. If the Prospector is not docked it will display
on the side.
2. Find point number 1110 in the preview window.
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3. Right-click on point 1110 and select Zoom to. You may want to zoom out some to see the
surrounding points.
4. Enter 3P at the command line to start the 3D Polyline command.
5. Enter 'PO to change the prompt to Point Object.
Alternatively, you can also select the Point Object button
Commands toolbar.

from the Transparent

6. Pick point 1110 from the screen.
7. Then pick points 1109, 1108, 1107, and 1106 to draw a breakline between the TOP points toward
the northeast corner of the site.
When using the Point Object transparent command to draw lines between point objects you
will not see the rubber band line that you normally see with the line command.
8. [Enter] to end the Point Object prompt.
9. [Enter] again to end the line.
10. Starting at point 1116, define a second breakline along the bottom of the ditch using the 3D
Polyline command with the 'PO transparent command and points 1116, 1117, 1118, 1119, and
1120.
11. [Enter] to end the Point Object prompt.
12. [Enter] again to end the line.
13. Starting at point 1111, define a third breakline along the bank of the ditch using the 3D Polyline
command with the 'PO transparent command and points 1111, 1112, 1113, 1114, and 1115.
14. [Enter] to end the Point Object prompt.
15. [Enter] again to end the line.
16. Save the drawing.
The three new 3D Polylines will look like the graphic below. However, they have not yet been
added to the surface as breaklines.
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5.1.6

Adding Breaklines to the Surface
1. Select Ribbon: Home ⇒ Layers ⇒ Isolate.

2. Pick one of the breaklines and one of the contours from the surface to isolate the BreaklinesSurvey and C-TOPO-Survey layers.
3. Confirm that the Definition under the Surface Survey is expanded on the Prospector tab of the
Toolspace.
4. Right-click on Breaklines under the Definition and select ⇒ Add.
5. Enter a Description for the breakline set of
Collected in Field.
6. Confirm that the Type is set to Standard.
You will not use any Weeding or Supplementing factors
in this exercise. These options allow you to remove or
add vertices to breaklines respectively. These are useful
options if you have breaklines that have been over
digitized and may have thousands of extra vertices very
close together or if you need to add vertices to a
breakline that has long distances between vertices.
7. Click <<OK>>.

8. Select the Breaklines with a crossing window.
9. [Enter] to add the breaklines to the surface.
The surface is now updated to include the new breakline data.
10. Select Ribbon: Home ⇒ Layers ⇒ Unisolate to restore the
previous layer state.

11. Save the drawing.
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5.1.7

Viewing the Surface

The Object Viewer is a separate window that will allow you to view a selected object or
objects in 3D and rotate them in real-time.
1. Pick one of the contours to highlight the entire surface.
2. Right-click and select ⇒ Object Viewer.
3. In the Object Viewer, click and drag while holding down the left mouse button to rotate the
surface in 3D.
Once you rotate to a 3D view the contours will change to 3D faces. This is controlled by the
surface object style.
4. If the surface is not shaded right-click and select Visual Styles ⇒ Shades of Gray.
5. Continue to rotate the surface to examine it from different angles. You will notice a large hole, or
spike, in the surface.

6. When you are finished viewing the surface close the object viewer window to return to the
drawing editor. You should also be able to identify this hole by looking at the contours in plan
view.
In the next lesson, you will learn to edit the surface to fix this and other errors.

Lesson: Building Surfaces from Survey Data

173

422

Index

Alignment
Alignment Editing
Alignment Label Sets
alignment label styles
Alignment Layout
appurtenances
ASCII File
Assemblies
Baselines
Boundaries
Breaklines
Capture Area
Command Line
Compound Queries
Contextual Ribbons
Contours
Coordinate system
Coordinate System
Corridor
Corridor Surfaces
Cut and Fill Depths
Data Shortcuts
Data Shortcuts Project Folder
Delete PI
DEM Files
Description Keys
Display Manager
Drafting Settings
Editing Surfaces
Elevation Banding
External References
fittings
Frequency
GIS Data
Grading Criteria
Grading Groups
grading objects
Grading Tools
Grid Volume Surfaces
Import Attributes
Import Coordinate Systems
Import Geometry
Import Interface
Import Spatial Filters
Importing Points
Insert PI
Inverse
Labeling AutoCAD Objects
Labeling Contours

73, 211
217
221
221
211
364
92
293
301
163
164
34
9
42
3
165, 196
31
19
301
302
398
409
411
217
165
91
7
9
175
184
409
364
302
19
381
381
381
382
397
19
19
19
20
19
92
217
136
144
196

Labeling Parcel Segments
Layout Profiles
Legal Description
Location Queries
Locking Point Groups
Locking Points
Map Explorer
Map Import
Mass Haul Diagrams
Match Line
Meets and Bounds
Multiple Parcel Properties
Network Parts List
Object Data
Offset Alignments
Online Map
Parcel Area Label Styles
Parcel Area Labels
Parcel Editing
Parcel Layout Tools
Parcel Reports
Parcel Segment Label Styles
Parcel Styles
Parcels
Paste Surface
Pipe Network Layout Tools
Pipe Network Profiles - Projected
Pipe Networks
Pipe Networks in Profile
pipes
Plan Production Tools
Point
Point Files
Point Group
Point Group Display Order
Point Groups
Point Import/Export formats
Point Label Style
Point Label Styles
Point Settings
Point Style
Point Styles
Pressure Network Layout
Pressure Network Parts List
Pressure Networks
pressure pipes
Profile Editing
Profile Label Sets
profile label styles

143
257, 277
136
40
99
99
7
19, 20
316
339
136
243
353, 364
20
223
33
242
136
230
231
136
243
242
135, 230
175
354, 365
359, 372
353, 364
359, 371
353, 364
337
78
166
79
109
99, 166
80
78
108
79
78
107
365
364
364
364
277
278
278
423

Profile Layout Tools
Profile View Bands
Profile View Styles
Profile Views
Profiles
Property Queries
Query
Query Tools
Regions
Ribbon
Sample Line Groups
Sample Lines
Saved Queries
Section Based Volumes
Section View Styles
Section Views
Sites
Stage Storage
Station and Offset Labels
Stationing
structures

424

277
279
258
258
257
41
38, 39
40
301
3
315
315
43
316
316
315
135
393
222
222
353, 364

Subassemblies
Surface
Surface Analysis
Surface Data
Surface Profiles
Surface Style
Surface Styles
Surveyors Certificate
Tables
Tags
Targets
Task Pane
Task-Based Ribbon
TIN Volume Surfaces
Tool-Based Ribbon
Transparent commands
Transparent Commands
User Interface
View Frame
Working Folder
Workspaces

293
61
184
163
257
62
196
136
144
143
301
7
8
398
8
73
128
1
338
410
8

A Practical Guide to
GIS in Autodesk Civil 3D® 2020

Rick Ellis and Russell Martin

A CADapult Press Publication

Copyright
Copyright © CADapult Press, Inc. 2019
All rights reserved. No part of this publication may be reproduced in any form, or by any means electronic,
mechanical, recording, photocopying, or otherwise, without written permission from the publisher, except for
brief quotations used in reviews, or for marketing purposes specific to the promotion of this work.
ISBN: 978-1-934865-45-3
Although CADapult Press has made every attempt to ensure the accuracy of the contents of this book, the
publisher and author make no representations or warranty with respect to accuracy or completeness of the
contents in this book, including without limitation warranties of fitness for a particular purpose. The datasets
included in this book are for training purposes only.
Autodesk screen shots reprinted with the permission of Autodesk, Inc.
Autodesk, AutoCAD, DWG, the DWG logo, Civil 3D and AutoCAD Map 3D are registered trademarks or
trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and other countries. All other
trademarks are the property of their respective owners.
Published in the United States of America by:
CADapult Press
(503) 829-8929
books@cadapult-software.com
Printed and manufactured in the United States of America

ii

About the Authors
Rick Ellis has worked with and taught Autodesk Civil 3D, along with Map 3D and other Autodesk products
since the mid-90s. He is the Author of several critically acclaimed books on Autodesk Civil 3D, Map 3D and
Land Desktop.
Rick continues to use Autodesk Civil 3D on projects in a production environment, in addition to teaching
classes to organizations both large and small.
This practical background and approach has made him an award winning speaker at Autodesk University, a
member of the national speaker team for the AUGI CAD Camps and a sought after instructor by organizations
around the world.
Rick can be reached at: rick@cadapult-software.com

Russell Martin is an independent consultant who has worked with CAD, GIS and cartographic design tools
since 1985. He has taught AutoCAD and AutoCAD Map 3D in small classrooms and at large events such as
Autodesk University. Russell has co-authored several books on AutoCAD Map 3D, and has served as
technical editor of many other books on CAD, computer graphics, Land Desktop and Civil 3D.
Russell also performs design, production mapping and GIS analysis services for a diverse client base, both
public and private. He uses AutoCAD, Map 3D and Civil 3D tools daily, to produce maps and graphics which
clearly communicate complex quantitative data.
Russell can be reached at: russell.p.martin@gmail.com

Exercise Data

CADapult Press would like to thank the City of Springfield, Oregon for providing the data for this book. The
dataset provided is for illustration purposes only. While it is based on real world information to add relevance
to the exercises, it has been altered and modified to more effectively demonstrate certain features as well as
to protect all parties involved. The data should not be used for any project work and may not represent actual
places or things. It is prohibited to redistribute this data beyond your personal use as a component of training.

iii

A Practical Guide to GIS in Autodesk Civil 3D 2020
Introduction

Congratulations on choosing this course to help you learn how to use GIS in Autodesk Civil 3D 2020. The
term “practical” is used in the title because this course focuses on what you need to effectively use the GIS
tools in Autodesk Civil 3D 2020, and does not complicate your learning experience with unnecessary details
of every feature in the product. Should you want to pursue aspects of features and functionality in greater
detail than provided in this course, you are directed and guided to that information.
Each lesson contains the concepts and principles of each feature to provide you with the background and
foundation of knowledge that you need to complete the lesson. You then work through real world exercises to
reinforce your understanding and provide you with practice on common tasks that other professionals are
performing with Autodesk Civil 3D 2020 in the workplace every day.
You can take the lessons in this course in whatever order is appropriate for your personal needs. If you want
to concentrate on specific features, the lesson for those features does not require that you complete prior
lessons. With this course organization, you can customize your own individual approach to learning Autodesk
Civil 3D.
When you complete this course, you will be armed with the background and knowledge to apply Autodesk
Civil 3D to your job tasks, and become more effective and productive in your job.

Course Objectives

The objectives of this course are performance based. In other words, once you have completed the course,
you will be able to perform each objective listed. If you are already familiar with Autodesk Civil 3D, you will be
able to analyze your existing workflows, and make changes to improve your performance based on the tools
and features that you learn and practice in this course.
After completing this course, you will be able to:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
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Work with coordinate systems
Clean drawings with common geometry errors
Insert rectified raster images
Work with a variety of attribute data
Apply object classification to your mapping system
Import GIS data from a variety of sources
Create surfaces and pipe networks directly from GIS data
Export geometry and attribute data to other GIS formats
Export Civil 3D objects to other GIS formats
Connect directly to GIS data
Access Data using the Autodesk Connector for ArcGIS
Connect to raster surface data
Attach and query source drawings
Save changes to attached source drawings
Extract data for reports and quantity takeoffs
Create, manage and analyze topologies
Utilize Dynamic Viewport Tools
Produce sophisticated map books

Prerequisites

Before starting this course, you should have a basic working knowledge of AutoCAD. A deep understanding
of AutoCAD is not required, but you should be able to:
•
•
•
•
•
•

Pan and Zoom in the AutoCAD drawing screen.
Describe what layers are in AutoCAD, and change the current layer.
Create basic CAD geometry, such as lines, polylines and circles.
Use Object Snaps.
Describe what blocks are, and how to insert them.
Perform basic CAD editing functions such as Erase, Copy, and Move.

If you are not familiar with these functions, you can refer to the AutoCAD Help system throughout the course
to gain the fundamental skills needed to complete the exercises.

Conventions

The course uses the following icons and formatting to draw your attention to guidelines that increase your
effectiveness in Autodesk Civil 3D, or provide deeper insight into a subject.
The magnifying glass indicates that this text provides deeper insights into the
subject.

The compass indicates that this text provides guidance that is based on the
experience of other users of Autodesk Civil 3D. This guidance is often in the form of
how to perform a task more efficiently.

The warning indicates that a specific exercise might not function properly on 64 bit
operating systems.

The workspace icon indicates the Workspace that will be used in the upcoming
exercise.
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Downloading and Installing the Datasets

In order to perform the exercises in this book, you must download a zip file and install the datasets.
Type the address below into your web browser to load the page where you can download the dataset.
www.cadapult-software.com/data
If you are using a previous version of Civil 3D you can download a previous version of the dataset to use with
this book.

Unzip the Files

Unzip the file APG_GIS2020.zip directly to the C drive. The zip file will create the following folder structure:
C:\A Practical Guide\GIS in Civil 3D 2020\Chapter Number\Files for Exercises

Exercises

The exercises in this course have been carefully chosen and designed to represent common tasks that are
performed by mapping and GIS professionals. The data included in the exercises are typical drawings and
maps used by local governments and municipalities. You work with road networks, parcel maps, sewer
collection systems, water distribution systems, aerial photos, raster surfaces, and much more.
Exercises provide higher level process information throughout the exercise tasks. You are given information
about not only what to do, but why you are doing it. In most cases, an image is included to help guide you.

64 Bit Database Drivers

On 64 bit systems, exercises that require a connection to an ODBC database need to have the proper drivers
from Microsoft installed. If your system does not have these installed, you can download them from Microsoft.
Go to [ http://www.microsoft.com ] and search for Microsoft Access Database Engine.
Be sure to download the 64 bit version of the Microsoft Access Database Engine. You do not need to have
Microsoft Office installed to install these drivers or to complete the exercise in this book. However, if you
have Microsoft Office installed it will need to be the 64 bit version of Office for the 64 bit drivers to install.
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5.1

Lesson: Importing GIS Data

Introduction

Importing GIS file formats into Civil 3D opens the door to a tremendous amount of data. Much
of this data is free and can be integrated into your mapping system. In this lesson, you begin
by learning the formats and types of data that can be imported into Civil 3D, and guidelines
around integrating other mapping data into your mapping system. You then import an
ArcView SHP file into Civil 3D.

Key Concepts

Concepts and key terms covered in this lesson are:
•

•

Import
o Geometry
o Attributes
o Coordinate Systems
Import dialog box

Objectives

After completing this lesson, you will be able to:
•
•
•
•
•
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Describe what Map Import is.
List the components that can be imported, and how Civil 3D interprets incoming data.
Identify and explain the tools used to import GIS data.
Import street segments with Object Data.
Import zoning polygons with an external data source.
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About Importing GIS Data into Civil 3D

GIS Data generally contains three types of data: geometry, attributes, and the coordinate
system it was created in. Using the map import tools, you can define how Civil 3D interprets
and imports all three types of data.
The Map Import commands are used to convert other GIS formats into AutoCAD objects with
attributes. These new AutoCAD objects are saved in the drawing file, with no link to the
original GIS source.
Civil 3D can also connect to data as a feature source and work with these files in
their native format. This functionality is covered in another lesson.

Geometry

All GIS formats are different. Civil 3D imports the data in such a way as to represent the
native format as closely as possible. An example of this functionality is when importing line
data from an ArcView shape file, any segments in the incoming file that have vertexes are
imported as polylines, while those that are simple lines with a start and endpoint are imported
as lines.
Points can be imported as either AutoCAD points, or blocks that are defined in the drawing.

Attributes

Attributes that are associated with incoming data can be mapped to Object Data, or can be
imported to an attached data source, such as a Microsoft Access database table, and linked
to the objects at the same time.

Coordinate Systems

If the incoming file has coordinate system information associated with it, either within the file
itself, or a companion file, Civil 3D will read this information and convert the coordinates to
the target drawing file. If there is no coordinate system information in the incoming file, you
can assign a coordinate system to it during the import procedure.

Spatial Filters

Some GIS applications can manage larger data sets than can be reasonably managed within
Civil 3D. Spatial filters enable you to limit the amount of data that you import based on a
location in the current map.

Guidelines for Preparing for Map Import

You can start a new drawing and simply import data. In most cases, you want to prepare a
target drawing with layers, Object Data tables, or attached data sources that will receive the
incoming data. This is especially true if your office has mapping standards that must be
adhered to, or if you are importing into an existing drawing that already has all the layers,
Object Data tables, or attached data sources present.
Another important point when preparing for an import is to have some familiarity with the
incoming data. This may come from metadata or documentation of some kind. The best way
to qualify the incoming data is to use the native application to review. However, this is not
always possible, in which case the import process might be a trial and error process until you
can make the correct settings for the final import.
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If you perform the same type of import regularly, you can save a profile of the
settings and load the profile each time you perform an import. You can also create a
drawing template that has all of the definitions such as Object Data tables, layers,
blocks and so on.

The Import Interface

Once the target file is prepared, and the incoming data is qualified, the entire import
procedure is performed in a single interface with various dialog boxes for the settings.
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Exercises: Import Data from Other GIS Formats

In these exercises you will import street centerlines that were sent to you as an E00 file. An
ArcInfo coverage may either be stored as a directory of related files, or exported into a single
E00 export file from ArcInfo or ArcGIS, as in this exercise.
Then you will, import parcel polygons from an ArcView Shapefile and convert their coordinate
system.
Finally, you will create centroids and move the attached data from each polyline to the
corresponding centroid. This is the first step in the process of cleaning the geometry, an
important process whenever base map data is imported.
The use of the import command is very similar for all the different types of supported GIS
data file formats. However, there are some differences depending on the type of geometry
that is contained in those files (points, lines, or polygons).

You do the following:
•
•
•

5.1.1

Import streets from an E00 file.
Import parcels from an ArcView shape file and convert its coordinate system.
Create centroids for the parcel polygons.

Importing an ArcInfo Coverage

For these exercises you should be in the Planning and Analysis workspace
In this exercise you will import street centerlines that were sent to you as an E00 file. An
ArcInfo coverage may either be stored as a directory of related files, or exported into a single
E00 export file from ArcInfo or ArcGIS, as in this exercise.
1. Press Ctrl + N and select the template map2d.dwt from the folder Map Book Templates, to start
a new, blank drawing.
2. Select Ribbon: Insert ⇒ Import ⇒ Map Import.
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The Import Location dialog box opens.

3. Set the file type to ESRI ArcInfo Export (E00).
4. Browse to the Chapter 05 folder, select streets.e00, and click <<OK>>.
In the Import dialog box you can configure the Layer, Coordinate Conversion, and Data
options that you wish to use to import the information into AutoCAD.

5. Ensure that the STREETS_arc Input Layer is selected.
6. Click on the Drawing Layer field in the STREETS_arc row, to activate the More button <<…>>.
7. Click the More button <<…>> to launch the Layer Mapping dialog box.
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Here you can choose to import the drawing objects onto an existing layer, create a new layer,
or select a column of data from the file that you are importing to determine the layer names.
This last option will allow you to do some basic thematic mapping during the import of the
objects. For example, if you were importing parcel data and that data set had a column for
zoning. You could have the import command create a new layer for each zoning type and
place each parcel on the appropriate layer for its zoning designation. (See Additional
Exercises at the end of this chapter for more information).
In this exercise, you will place all of the streets on one new layer.
8. Choose the Create on new layer option to activate the text
box.
9. Enter "Streets" for the layer name.
10. Click <<OK>> to return to the Import dialog box.

11. Click on the Data field in the STREETS_arc row to activate the More button <<…>>.
12. Click the More button <<…>> to launch the Attribute Data dialog box.
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Here you specify what attribute data to import and where to store it. You can enter the
desired name for the Object Data Table and select the desired fields to import. This is the
step that allows you to bring the intelligence of the GIS file along with the geometry into
AutoCAD. By creating the object data table and populating it with the information provided in
the coverage you will be able to click on a street and find the street name, type, speed limit,
and any other information that was added by the GIS department. This will also allow you to
edit the geometry and data from the GIS file in AutoCAD and then export it back to any of the
supported GIS formats without losing any of the attached data. If you leave the Data option
set to None or Do not import attribute data, then you will only import the geometry of the file
and you will lose all of the attached information.
13. Choose the Create object data option to activate the
Object Data section.
14. Change the Object Data table name to Streets.
15. Click <<Select Fields>>.

Here you specify which fields to import into the Object Data table.
16. Deselect all Input Fields except NAME_FULL, TYPE,
SPEED, OWNER, PAVED, and FCLASS.
You only need to import the fields that you want to have available.
So if there is extraneous data that you don't need, you can skip it
and keep the file size smaller.
It is also important to understand that many GIS programs store
geometric data, like length and area, in data tables, while in
AutoCAD the geometry is a physical property of the object. In this
example, if you were to import the length field, it would be a static
value in the object data table and would not update if the length of
the line is altered.
17. Click <<OK>> to dismiss the Object Data Mapping
dialog box.
18. Click <<OK>> to dismiss the Attribute Data dialog box.
19. Click <<OK>> in the Import dialog box to import the file.
The streets are imported into the drawing as polylines, with the GIS data attached as Object Data.
20. Once the 287 objects are imported, zoom to Extents.
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21. Select Ribbon: Tools ⇒ Map Edit ⇒ Edit Object Data.

22. Pick a line segment anywhere in the drawing.

Here, you can view the object data associated with the line segment you picked. You can
also change the value of any field in this object’s data, or even add a record to a new or
existing object. It is also possible to view and edit object data as an AutoCAD property.
23. View the object data associated with a few other line segments.
24. Click <<Cancel>> once you are through viewing the fields, to avoid saving any inadvertent
changes.
25. Save the drawing as Streets in the Chapter 05 folder.
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5.1.2

Importing Polygons from an ArcView Shapefile

For this exercise you should be in the Planning and Analysis workspace.
In this exercise you import parcel polygons from an ArcView Shapefile. This Shapefile
geometry resides in a different coordinate system, and will be converted during the import
process.
1. Open City Taxlots OD.dwg from the Chapter 05 folder.
This drawing contains the city taxlots file that you worked with in previous chapters, with the
Taxlot attribute data as object data, attached to the centroids.
The county taxlots you are about to import are in a different coordinate system, which Civil
3D will convert during the import process. The first step is to assign the correct coordinate
system to the base map.
2. Select Ribbon: Map Setup ⇒ Coord System ⇒ Assign.

3. Click <<Select Coordinate System>> in the Current Drawing section, to open the Coordinate
System - Assign dialog box.
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4. From the Category list, select USA, Oregon.
5. From the list, select OR-S NAD27 Oregon State Planes (Polyconic), South Zone, US Foot.
Notice the column of codes on the left, and that the code for the selected coordinate system
is OR-S.
Once you become familiar with commonly used coordinate systems in your region,
you can learn the short codes and simply enter them in the Coordinate System Assign dialog box.
6. Click <<Assign>> to assign the Global Coordinate System.
The drawing is now identified with the NAD 27 State Plane coordinate system - no conversion
has occurred; you have simply assigned that coordinate system to this drawing. The Ribbon
now displays the Geolocation tab.
Next, you will import the county GIS data, which is in a different coordinate system, and Civil
3D will convert it to this coordinate system.
7. Select Ribbon: Insert ⇒ Import ⇒ Map Import.

The Import Location dialog box opens.

8. Set the file type to ESRI Shapefile (*.shp).
9. Navigate to the Chapter 05 folder and select TL_C_83.
10. Click <<OK>> to launch the Import dialog box.
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Here you specify all import parameters.

11. Click on the Drawing Layer field in the TL_C_83 row to activate the More button <<…>>.
12. Click the More button <<…>> to open the Layer Mapping dialog box.

13. Choose the Create on new layer option to activate the text field.
14. Enter Taxlot_County for the new layer name.
15. Click <<OK>> to return to the Import dialog box.
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Notice that the Current drawing coordinate system (the base map into which you are now
importing this Shapefile) is in NAD27, which you set at the beginning of this exercise.
Also notice that the Input Coordinate System is showing OR83-SF, which is the code for
NAD83 Oregon State Planes (Polyconic), South Zone, US Foot.
Civil 3D is getting this information from the PRJ file, that accompanies the .SHP file. This file
contains the coordinate system information. When you acquire shapefiles from others, always
ask for coordinate system information. If there is not an accompanying PRJ file, but the
coordinate system is known, you could use the More button <<…>> in the Input Coordinates
field to select it manually, using the Coordinate System Library.

16. Click on the Data field to activate the More button <<…>>.
17. Click the More button <<…>> to open the Attribute Data dialog box.
18. Choose the Create object data option to activate the
External Database section.
19. Select Parcels from the Object data table list.
The object data table exists in the City Taxlots
OD drawing.
Civil 3D will add the new records to the existing
object data table during the import process.
20. Click <<OK>> to return to the Import dialog box.
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21. Enable the Import polygons as closed polylines option.
This will create each taxlot as a closed polyline, as opposed to a polygon object.
22. Click <<OK>> to import the file.
Civil 3D will process 396 objects and import them into the current drawing and will append
396 corresponding records to the attached database.
23. Zoom to Extents. Your drawing should look like this:

The county parcels have been imported and converted to the coordinate system of the city
taxlots drawing.
24. Save the drawing as Regional Taxlots.dwg in the Chapter 05 folder.
174

Lesson: Importing GIS Data

Chapter: Importing and Exporting
5.1.3

Creating Centroids

For this exercise you should be in the Planning and Analysis workspace.
In this exercise you will first create centroids and move the attached data from each polyline
to the corresponding centroid. This is the first step in the process of cleaning the geometry,
an important process whenever base map data is imported.
1. Continue working in the Regional Taxlots.dwg that you created in the last exercise.
2. Freeze the Taxlots and Centroid layers to isolate the Taxlot County layer.
3. Select Ribbon: Create ⇒
Drawing Objects ⇒
Create Centroids.

The Create Centroids dialog box opens.

4. In the Create Centroids in section, choose Selected only:
5. Click the select objects button
This temporarily closes the dialog box so you can pick the objects.
6. Pick all the polygons with a crossing window and press Enter.
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7. Click the New Layer button
centroids.

to make the layer Centroid_County on which to create the

8. Confirm that ACAD_POINT is selected in the Create using field.
9. Click <<OK>> to create a centroid for each closed polygon.
This creates a point at the geometric center of each polygon and moves the data from the
polyline to the new centroid.
10. Pick one of the new centroids, then right-click and select ⇒ Properties.
11. In the Properties palette, scroll to the
bottom and notice the attribute data from
the SHP file is now attached to the tax lot
centroids.

12. Save the Drawing.

Lesson Review

In these exercises you imported street centerlines that were sent to you as an E00 file. An
ArcInfo coverage may either be stored as a directory of related files, or exported into a single
E00 export file from ArcInfo or ArcGIS, as in this exercise.
Then you imported parcel polygons from an ArcView Shapefile and converted their
coordinate system.
Finally, you created centroids and moved the attached data from each polyline to the
corresponding centroid. This is the first step in the process of cleaning the geometry, an
important process whenever base map data is imported.
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7.3

Lesson: Connecting to Raster and Raster Surfaces

Introduction

Connecting to raster data as a feature source is similar to inserting images using Image
Insert. In each case, the file is only referenced and not part of the drawing itself. In this
lesson, you also learn the differences between these two methods and the advantages of
using the feature source connection. You also learn about the tools that are used to connect
to a raster image, and then connect to a raster image.
Connecting to raster surfaces is similar to connecting to raster images. The main difference is
that raster surfaces contain elevation data associated with each pixel. Civil 3D uses this
method for simple surface analysis and visualization as part of the feature source. In this
lesson, you learn the basic concepts of raster surfaces, the types of files that you can access,
and how raster surfaces can be used as part of your mapping system. You then connect to a
digital elevation model, and add it to your map.

Key Concepts

Concepts and key terms covered in this lesson are:
• Raster feature sources
• Raster surfaces
• Viewing raster surfaces in 3D
• Draping raster and vectors over surfaces

Objectives

After completing this lesson, you will be able to:
• Describe what a raster feature source is.
• List the types of raster formats that can be accessed.
• Explain how raster surfaces can be used.
• Connect to an ortho photo.
• Connect to a raster surface.
• Drape vectors and raster over a raster surface.
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Raster Feature Source Concepts

You can use raster data in Civil 3D through the Map Image Insert command and by
connecting to raster as a feature source. There are some very powerful reasons to use a
feature source connection rather than inserting raster:
•
•
•

Performance
File formats
Coordinate conversion

Performance

The performance of raster as a feature source is much better than that of raster inserted in a
drawing. In some cases this performance enables access to raster that otherwise cannot be
used because of file size.

File Formats

Connecting to raster as a feature source opens a larger selection of geospatial-based file
formats to work with. In addition to the formats that are offered directly in standard Civil 3D,
the fact that the feature data objects (FDO) technology is open source enables developers to
write additional FDO providers to access even more file formats.
The following illustration shows the file formats available in the Map Image Insert command.
While it offers a wide variety of file formats to select from, when considering the geospatial
specific formats, it is fairly limited.
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The following illustration shows the file formats available when connecting to raster as a
feature source. The formats available through this method are especially useful for geospatial
applications.

Coordinate Conversion

Connecting to raster as a feature source enables the coordinates of the raster to be
converted to the coordinates of the current drawing. This is a very important distinction
between connecting and inserting raster. When using Map raster insert, whatever the
coordinates of the raster are determines the coordinates of your map. This is very limiting
when compared to the coordinate conversion available using a raster feature source
connection.

Raster Surface Concepts

When working with raster as feature sources, the process and procedures to connect and
add both standard raster and raster surfaces are the same.

Both types of raster are composed of pixels. In the case of raster surfaces, each pixel has a Z
value rather than a value such as grey scale or color that produces a “picture”. Civil 3D can
interpret the Z values in a raster surface, and produce three dimensional views and analysis.

Lesson: Connecting to Raster and Raster Surfaces

261

Chapter: Using Raster Images in Maps

Raster Feature Layers

When a raster is connected to, and added to a map, the management of the feature layer is
the same as that of vector based feature layers.

Working with Raster Surfaces

There are several tools available to take advantage of the elevation data that is inherent in a
raster surface. These tools include creating contours, slope, aspect, and elevation analysis,
draping, and assigning exaggeration values to the elevations. In this lesson, you work with
draping and exaggeration.

Draping

Draping refers to vector and raster objects which adopt the three dimensional characteristics
of the underlying surface. By default, when a raster surface feature layer is present in a
drawing, all other feature layers, both vector and raster drape over the raster surface
depending on the draw order of the feature layers.

AutoCAD objects do not drape over raster surfaces.
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Exaggeration

Exaggeration can be applied to raster surfaces to create a more impactful representation of
the terrain when needed.
In the following illustrations, the image on the left is a raster viewed in 3D with no
exaggeration. The image on the right is the same raster surface with an exaggeration value
of 3x.

Exaggeration should be used sparingly. It often dramatically misrepresents the map.

Exercises: Connecting to Raster and Raster Surfaces

In these exercises, you start in a drawing that has a parcel feature layer connected. You
connect to a raster image of an ortho photo of the area of interest. You then connect to a
raster surface, change the draw order, and view the map in 3D.

You do the following:
•
•
•
•

Connect to a raster image and add it to the map.
Change the draw order to view the parcels on top of the raster.
Connect to and add a raster surface to the map.
Set the draw order to drape the parcels and ortho photo over the surface.
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7.3.1

Connecting to an Aerial Photo

For this exercise you should be in the Planning and Analysis workspace.
1. Open the drawing Connect to Raster.dwg from the Chapter 07 folder.
In the first series of steps, you connect to the raster image and add it to the map.
2. If the Task Pane is not visible, at the command line enter:
Command: MAPWSPACE.
3. At the command line, enter ON to display the Task Pane,
which includes the Display Manager.
4. In the Display Manager, confirm that the Groups button
is selected.
5. In the Display Manager, click the Data button, and then
select ⇒ Connect to Data… .

The Data Connect palette opens. Here you can select from many different data providers or
sources. In this exercise you will be connecting to a raster image file.

6. From the Data Connections by Provider list, select Add Raster Image or Surface Connection.
7. Change the Connection name: to Ortho.
8. Click the file button
and select Aerial.tif.

and browse to: C:\A Practical Guide\GIS in Civil 3D 2020\Chapter 07,

9. Click <<Connect>>.
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10. Click <<Add to Map>>.
11. Close the Data Connect palette.
Notice the feature layer Aerial now appears in the Display Manager. A layer in the Display
Manager is different than an AutoCAD layer; it is the name of a data source and where you
manage its properties.
Notice the aerial photo is on top of the parcels.
12. In the Display Manager, select the Draw Order button.
The list of feature layers is displayed in the current draw order. The order these are listed in
matches the feature layers in the drawing.
13. Drag the Parcels feature layer above the Aerial layer.
The first time you change the sequence of the Display Map Draw Order list in a drawing, an
alert is displayed, informing you that the Draw Order list will now control the visual display of
feature layers.

14. Click Continue action and allow Draw Order to control layer position from now on.
15. Zoom into the map to view the image with the parcels overlaid.
Lesson: Connecting to Raster and Raster Surfaces

265

Chapter: Using Raster Images in Maps
16. Save the drawing for use in the next exercise.

7.3.2

Connecting to a Raster Surface

In this exercise you connect to and add to the map an elevation enabled raster, or raster
surface. Once the surface raster is added to the map, you change the draw order, and view
the map in 3D. Any feature layer that is on top of the surface will automatically drapes over
the surface.
1. Continue working in Connect to Raster.dwg from the previous exercise.
If you did not complete the previous exercise you can open the drawing Connect to
Surface.dwg.
2. Connect to a Raster Surface. Repeat Steps 5-11 from the previous exercise using the following
information:
•
•

For the Connection Name enter Elevation
Connect to the file Existing Ground.dem in the Chapter 07 folder
3. In the Display Manager, select Draw Order.

The list of feature layers is displayed in the current draw order. The order these are listed in
matches the feature layers in the drawing.
4. Drag the feature layers to match the following order:
o
o
o

Parcels
Aerial
Existing Ground

To view the Parcels and Aerial features draped over the Existing Ground DEM feature, you
need to switch the drawing editor from 2D to 3D views. The tools to switch views reside on
the Map Status Bar. In the standard, out-of-the-box installation of Civil 3D, this status bar is
not displayed by default. The display of the Map Status Bar is controlled by a system
variable.
5. Enter MAPSTATUSBAR on the Command Line, and select <Show>.
The Drawing Status Bar now shows additional tools for some AutoCAD Map 3D functions,
such as 2D / 3D Viewing, Vertical Exaggeration, Coordinate Systems and View Scale.
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6. In the Drawing Status Bar, click the 3D icon.
The drawing is displayed in 3D.

7. In the Status bar, for Vertical Exaggeration,
select 2x.
Note: It might take a few moments to optimize the layer.
8. Zoom into the drawing to view how
the raster and parcels are draped
over the surface raster.
9. Experiment with various Vertical
Exaggeration values and 3D viewing
angles.
10. In the Display Manager, turn the
Aerial image off, and notice how the
vector data in the Parcels layer are
draped over the surface.

NOTE: Be careful when applying Vertical Exaggeration, and use it sparingly. While it can help
visualize terrain in relatively flat areas, it can dramatically misrepresent actual conditions.

Lesson Review

In these exercises you integrated three different sources of data. Vector based parcels, an
ortho photo, and a surface. Together, these sources of data were combined to view how the
parcels and the image drape over the existing ground terrain.
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